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How to read this manual

Symbols
In this manual, the following symbols are used with the items where important 
operational and safety information must be observed.

Symbol Meaning

Describes warnings to protect yourself and others from serious or 
potentially fatal injury if you handle the machine incorrectly. 
For safe operation, please follow instructions carefully.

Notes a caution to protect yourself and others from personal injury or 
damage to properties if you handle the machine incorrectly. 
For safe operation, please follow instructions carefully.

IMPORTANT
Describes important conditions or restrictions you should carefully 
observe to avoid problems caused by incorrect operations.

NOTE Describes reference information and additional notes for operation.

Key descriptions
In this manual, the operating keys are described as follows:
<  > :   Keys on the control panel.
        For example, the start key  <Start>
[   ] :  Buttons on the display and computer.
        For example, the “Setting” button  [Setting]
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Descriptions for paper and documents
 symbol : �This shows that paper should be set with the shorter side positioned at the 

top.

 symbol : �This shows that the document should be set with the shorter side positioned 
at the top.

       

ABC

Screens
This manual uses the screens of the bizhub 28e standard model, unless otherwise stated. 
The screens you see may differ, depending on the options installed.



Chapter 1
Installing the driver

Drivers and utilities introduction...........................................................................1-2
Drivers and utilities included on the installation disk..........................................1-2
Supported operating system for the drivers...........................................................1-3

System requirements..................................................................................................1-4
Windows environment.............................................................................................1-4
Macintosh environment...........................................................................................1-5

Installing to Windows.................................................................................................1-6
Installing via network connection...........................................................................1-6
Using the machine as a shared printer.................................................................1-10
Installing a printer driver via IPP (Internet Printing Protocol).........................1-12
Installing via local connection...............................................................................1-16
Setting up printer options.....................................................................................1-22

Installing to Mac OS X..............................................................................................1-23
Installing via network connection.........................................................................1-23
Installing via a local connection............................................................................1-25
Using the machine as a shared printer.................................................................1-26



1-2    Drivers and utilities introduction

Drivers and utilities introduction

Drivers and utilities included on the installation disk
Following drivers and utilities are included on the installation disk that is supplied with 
the machine.
In this guide, we describe how to use the printer drivers.  To see how to use other drivers 
and utilities, see the guides mentioned in the table.

Name Description

GDI printer driver This is the standard Windows printer driver.

PCL 6 printer driver This printer driver uses the page description language PCL 6.

PCL 5e printer driver This printer driver is for ensuring compatibility with legacy PCL 
printers.

PostScript 3 printer driver*1 This printer driver is for printing documents that include PostScript 
fonts and EPS data. 

PDF direct print 
application*1

This utility enables you to print PDF files without using an 
application. 

FAX driver This driver is for sending created documents to a fax destination or 
e-mail address directly from a computer.
For details, see chapter 3, “Transmitting faxes from a computer” in 
the Scanner and Fax Guide.

Scanner driver This driver is for scanning documents from an applications that 
supports TWAIN.
For details, see chapter 1, “Scanning with a TWAIN driver” in the 
Scanner and Fax Guide.

Scan to Print Monitor This utility application is to print color documents scanned on the 
machine in color from a color printer on the network.
For details, refer to Chapter 1, "Scan to printer" in “Basic scanning” 
in the Scanner and Fax Guide.

*1	 To use the driver, the optional “PostScript Enabler” is required.
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Supported operating system for the drivers
You can install the following types of drivers and utilities.

Item

Windows 10
Windows 8
Windows 7
Windows Vista

Windows XP Windows Server 2012 R2
Windows Server 2012
Windows Server 2008 R2
Windows Server 2008
Windows Server 2003

Mac OS X

GDI printer driver   

PCL printer driver   

PostScript 3 printer driver    

PDF direct print application   

Fax driver   

Scanner driver

  
For Windows Server 2012 
R2, Windows Server 2012, 
Windows Server 2008 R2, 
and Windows Server 2008, 
network connection only.

Scan to Print Monitor   

 : Supported,   Blank : Not supported
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System requirements

Windows environment
To use your machine as a printer or a scanner, use a computer meeting the following 
specifications.

Item Specifications

CPU
Any processor of the same or higher specifications as recommended for 
your operating system.

Operating System *1

Windows 10 Enterprise (×86/×64)
Windows 10 Education (×86/×64)
Windows 10 Pro (×86/×64)
Windows 10 Home (×86/×64)
Windows 8 (×86/×64)
Windows 8 Pro (×86/×64)
Windows 8 Enterprise (×86/×64)
Windows 7 Home Premium (×86/×64)
Windows 7 Ultimate (×86/×64)
Windows 7 Professional (×86/×64)
Windows 7 Enterprise (×86/×64)
Windows Vista Home Basic (×86/×64)
Windows Vista Home Premium (×86/×64)
Windows Vista Ultimate (×86/×64)
Windows Vista Business (×86/×64)
Windows Vista Enterprise (×86/×64)
Windows XP Home Edition
Windows XP Professional
Windows XP Professional ×64 Edition
Windows Server 2012 R2 Datacenter (×64)
Windows Server 2012 R2 Standard (×64)
Windows Server 2012 R2 Essentials (×64)
Windows Server 2012 R2 Foundation (×64)
Windows Server 2012 Datacenter (×64)
Windows Server 2012 Standard (×64)
Windows Server 2012 Essentials (×64)
Windows Server 2012 Foundation (×64)
Windows Server 2008 R2 Standard (×64)
Windows Server 2008 R2 Enterprise (×64)
Windows Server 2008 R2 Datacenter (×64)
Windows Server 2008 Standard (×86/×64)
Windows Server 2008 Enterprise (×86/×64)
Windows Server 2008 Datacenter (×86/×64)
Windows Server 2003 Standard Edition
Windows Server 2003 Standard ×64 Edition
Windows Server 2003 Enterprise Edition
Windows Server 2003 Enterprise ×64 Edition
Windows Server 2003 Datacenter Edition
Windows Server 2003 Datacenter ×64 Edition

Free hard disk space 10 MB or more
Memory Memory capacity as recommended for your operating system.
Drive CD/DVD drive 

Interface
Ethernet 10BASE-T/100BASE-TX
USB 2.0 (Hi speed)

Protocol Standard TCP/IP (LPR/LPD, Port9100), IPP

*1	 Please see the latest supported OS on our home page.
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Macintosh environment
The system requirements for the installer are as follows.

Item Specifications

CPU
Any processor of the same or higher specifications as recommended for 
your operating system.

Operating System *1 Mac OS X (10.2, 10.3, 10.4, 10.5, 10.6, 10.7, 10.8, 10.9, 10.10, 10.11)

Free hard disk space 10 MB or more

Memory Memory capacity as recommended for your operating system.

Drive CD/DVD drive

Interface
Ethernet 10BASE-T/100BASE-TX
USB 2.0 (Hi speed)

*1	 Please see the latest supported OS on our home page.

NOTE

•	Only “PostScript 3 printer driver” is available on Macintosh environment.
•	To use the PostScript 3 printer driver, the optional “PostScript Enabler” is required.
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Installing to Windows
Please read the following instructions to install printer drivers to Windows operating 
system.  When you connect the machine via network, see “Installing via network 
connection” (page 1-6).  When you connect the machine and computer with USB cable, 
see “Installing via local connection” (page 1-16).

Installing via network connection
An IP address is required to install the network driver and use your machine as a 
network printer and network scanner.  You need to obtain the IP address from your 
network administrator and register it.  For details on the IP address settings, see chapter 2, 
“Specifying the network settings” in the Administrator’s Guide.

�� Installing driver 

NOTE

•	You must have administrator privileges in order to install the printer driver.
•	If the [User Account Control] window appears when installing on Windows 10 / 

Windows 8 / Windows 7 / Windows Vista / Windows Server 2012 R2 / Windows 
Server 2012 / Windows Server 2008 R2 / Windows Server 2008, click [Continue] or 
[Yes].

•	If a message regarding the certificate is displayed during installation, click [Install 
this driver software anyway], [Continue Anyway] or [Yes]. (The displayed message 
and button names may differ according to the version of the operating system you 
are using.)

1	 Insert the installation disk into the CD-ROM drive of the computer.
•	The installer starts automatically.
•	If the installation top screen is not displayed, double-click the “InstMenu.exe” file on the 

disk.
•	If the “AutoPlay” dialog box appears, click [InstMenu.exe].

2	 Select your machine name from the “Select Model” menu, and click  
[Install Drivers].
Click the “Select Language” menu to select the language to display the installer in.

3	 Read the license agreement, and click [I agree] if you agree with the terms.
•	Click [I disagree] return to the installation top screen.
•	Click [< Back] to return to the installation top screen.

4	 Select “Network (connected via LAN cable)”, and click [Next >].

5	 Select the installation type, and click [Next >].
•	If you selected “Typical Installation (Recommended)”, PCL 6 printer driver and scanner 

driver will be installed.  Proceed to step 12.
•	If you selected “Custom Installation”, proceed to step 6.

6	 Select the drivers to install, and click [Next >].
Clicking the “+” allows to expand the menu.

7	 Select the utilities to install, and click [Next >].
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Installing to Windows    1-7

8	 Specify the location to install the utilities, and click [Next >].
•	This screen may be displayed, depending on the selected drivers and utilities.
•	You can click [Browse] to display the folder browsing dialog and specify the installation 

location.

9	 Select the program folder, and click [Next >].
•	This screen may be displayed, depending on the selected utilities.
•	When you register utilities in the Start menu, specify the program category you want them 

to belong to.

10	Select the utilities to start automatically, and click [Next >].
•	This screen may be displayed, depending on the selected drivers and utilities.
•	The utilities registered here are automatically started when the computer starts.

11	Select the utilities to create a shortcut for, and click [Next >].
This screen may be displayed, depending on the selected drivers and utilities.

12	Enter the IP address of the machine to connect to, and click [Next >].
•	If you do not know the IP address, you can detect the IP address of connected devices on 

the “Device Search” screen.  First, click [Search] to display the device search screen.  If the 
“Windows Security Alert” screen is displayed, click [Unblock] or [Allow access], and then 
click [Refresh] if the device is not detected.  Select the device name from the list, and click 
[OK].  (The “Windows Security Alert” screen is not displayed from the second time you 
perform this operation.)

•	If you want to create a shortcut to Message Board on the desktop, select “Create the shortcut 
to Message Board”.

13	Click [Install].

14	When the installation completes, a screen indicating that the installation is 
complete is displayed.  Click [Finish].

15	Set up user authentication and security print test print as needed.
•	For details on the user authentication, see “Setting up user authentication” (page 1-8).
•	For details on the security printing test, see “Security printing test” (page 1-9).

16	Click [Exit] to complete the installation.

17	Remove the installation disk from the CD-ROM drive.

NOTE

When the optional devices are attached to your machine, see “Setting up printer 
options” (page 1-22) to enable these device.



1-8    Installing to Windows

�� Setting up user authentication
The following screen appears after installing the driver.
When you set up user authentication here, authentication user set the printer drivers 
(except PCL printer driver), and fax driver can be set at one time.

“Extended Functions” tab of the printer driver. “Fax Settings” tab of the fax driver.

1	 Click [User Authentication].

2	 Select user name, and enter the password.

3	 Click [OK].
The selected user is set as the authenticated user to all installed printer and fax driver, except 
PCL printer driver. 

NOTE

To be an authenticated user, you should be a registered user of Message Board in 
advance.  For details on the registering users, see chapter 2, “Registering users” in the 
Message Board Guide.
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�� Security printing test
The following screen appears after installing the driver.  
To test security printing, click [Security Print test print].

1	 Click [User Authentication], and set up the user authentication. 
For details, see “Setting up user authentication” (page 1-8).

2	 Click [Security Print test print].
Click [OK] to close the confirmation screen.

3	 Log in to the machine.
Press <Login>  select your user ID  [Enter]  if necessary, enter the password  [Enter].

4	 Start security printing.
Press [Print] on My MFP Menu screen  [Security Print]  [Print]  [Yes]. 
If My MFP Menu screen is not displayed, press <Mode> repeatedly until My MFP Menu 
screen is displayed.

5	 Log out the machine.
Press <Login>, then press [Yes].
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Using the machine as a shared printer
If you are going to use the machine as a shared printer on a Windows network with the 
printer driver installed on a print server, follow the steps below to install the printer 
driver on the print server and the client computers.

NOTE

•	For details on the configuring settings on the print server, see the operation 
manual or the help file of the operating system.  The “print server” explained here 
is a computer that is connected directly to the machine, and “clients” are other 
computers connected to the print server on the same network.

•	Install the same printer driver on client computers as the printer driver that is 
installed on the print server.

�� Sharing the printer on the print server
The “print server” explained here is using Windows Server 2008.

1	 Install the printer driver.

2	 Right-click the printer icon to share, then click “Sharing…”.

3	 Click the [Change sharing options].

4	 Enter the share name.
If the client computer is using a different version of Windows from the printer server, install 
the additional driver following the steps below.
1. Click [Additional Drivers…] on the “Sharing” tab.
2. Click the check box of the system you want to install, then click [OK].
3. Insert the driver CD and select the driver from the following folders on the CD.
•	GDI driver location: 

D:\Package\ENU\bizhub28e\GDI\INSTDATA\Printer\NT
•	PCL 5e driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\5e\NT
•	PCL 6 driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\6\NT
•	PostScript 3 driver location: 

D:\Package\ENU\bizhub28e\PS3\INSTDATA\Printer\NT
In this description, the letter of CD drive is “D”.  Substitute the letter of your CD-ROM drive 
for “D”.
4. Follow the instructions that appears on the screen.

5	 Click [Close].
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�� Installing the printer on the client computers

NOTE

Ask your network administrator for the server name and printer name of the machine 
on the network.

1	 Open the network computer window, and double-click the print server.

2	 Double-click the shared printer name.
The printer driver will be installed automatically.



1-12    Installing to Windows

Installing a printer driver via IPP (Internet Printing Protocol)
To use your machine as a printer with IPP, install the printer drivers using the “Add 
Printer” wizard.

NOTE

•	You must have administrator privileges in order to install the printer driver.
•	To use the printer driver via IPP, confirm in advance that your network environment 

can use the HTTP protocol.
•	Enable the IPP port from Message Board screen in advance.  Log on to Message 

Board as an administrator, click [Machine Mgmt. Settings]  [Secure Settings]  
[Machine Policy Settings], then open “Service setting”, and set the “IPP” setting 
underneath “PC Print” to ON.

•	To specify the printer name, confirm in advance that your network environment can 
use DNS.

•	When using the GDI printer driver via IPP, you cannot use the enlarge/reduce, 
combine, and booklet functions.

•	When using the FAX driver via IPP, you cannot use the enlarge/reduce function.

�� �Preparation for Windows Server 2012 R2 / Windows Server 
2012 / Windows Sever 2008 R2 / Windows Sever 2008
When using Windows Server 2012 R2, Windows Server 2012, Windows Server 2008 R2 
or Windows Server 2008, settings must be specified in the operating system before the 
printer driver is installed.

When using Windows Server 2012 R2 and Windows Server 2012

1	 Click “Server Manager” icon on the task bar on the “Desktop” screen.
If the “Server Manager” icon is not displayed on the task bar, click “Control Panel” on the “Start” 
screen, then click “Administrative Tools”, and double-click “Server Manager”.

2	 Click “Add roles and features” in the “Dashboard” windows.

3	 Click [Next], until the “Features” screen appears.

4	 Select the [Internet Printing Client] check box to install the feature.

5	 Restart the computer.

When using Windows Server 2008 R2 and Windows Server 2008

1	 Click the [Start].

2	 Point to [Administrative Tools], and then click [Server Manager].
If the [User Account Control] dialog box appears, click the [Continue] or the [Yes].

3	 In the [Server Manager] main window, click [Add Features] in the [Features 
Summary] section.

4	 Select the [Internet Printing Client] check box to install the feature.

5	 Restart the computer.
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�� �Adding an IPP port using “Add Printer Wizard” 
(Windows 10 / Windows 8 / Windows 7 / Windows Vista / Windows Server 2012 
R2 / Windows Server 2012 / Windows Server 2008 R2 / Windows Server 2008)

1	 Insert the setup disk into the CD-ROM drive of the computer.
When the driver installer screen appears, click [Close].

2	 Click [Start], and then click [Control Panel].
•	When using Windows 10, click “All apps” in Start menu, then “Windows System”, and then 

“Control Panel”.
•	When using Windows 8, click “Desktop”  in Start screen, then “Settings” in charm, and then 

“Control Panel”.
•	When using Windows Server 2012 R2, Windows Server 2012, click “Control Panel” on the 

“Start” screen.

3	 Click [Printer] under [Hardware and Sound].
•	When using Windows 10, Windows 8 and Windows 7, click [View devices and printers] under 

[Hardware and Sound].
•	When using Windows Server 2012 R2 and Windows Server 2012 and Windows Server 2008 

R2, click [View devices and printers] under [Hardware].

4	 Click [Add a printer].

5	 Click [Add a network, wireless or Bluetooth printer].
When using Windows Server 2012 R2, Windows Server 2012, Windows Server 2008 R2, 
Windows Server 2008, skip this step.

6	 Click [The printer that I want isn’t listed].

7	 Select “Select a shared printer by name”, and enter the machine’s network path 
in the following format, then click [Next]:
http://IP address:HTTP port number/ipp
Example: �When the machine’s IP address is 192.168.1.20, and HTTP port number is 80, enter 

http://192.168.1.20:80/ipp.

8	 Click [Have Disk].

9	 Click [Browse].

10	Locate the directory on the CD-ROM where the printer driver files are located 
and then click [Open].
•	GDI driver location: 

D:\Package\ENU\bizhub28e\GDI\INSTDATA\Printer\NT
•	PCL 5e driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\5e\NT
•	PCL 6 driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\6\NT
•	PostScript 3 driver location: 

D:\Package\ENU\bizhub28e\PS3\INSTDATA\Printer\NT
•	Fax driver location: 

D:\Package\ENU\COMMON\FAX\INSTDATA\Printer\NT
In this description, the letter of CD drive is “D”.  Substitute the letter of your CD-ROM drive 
for “D”.

11	Click [OK].
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12	Click [OK].

13	Follow the instructions on the screen.
•	If the [User Account Control] dialog box appears, click the [Continue] or the [Yes].
•	If the Windows Security screen is displayed, click [Install this driver software anyway].

14	Click [Finish].

NOTE

When the optional devices are attached in your machine, see “Setting up printer 
options” (page 1-22) to enable these device.

�� �Adding an IPP port using “Add Printer Wizard” 
(Windows Server 2003 / Windows XP)

1	 Insert the setup disk into the CD-ROM drive of the computer.
When the driver installer screen appears, click [Close].

2	 Open the “Add Printer Wizard” dialog box.
Click [Start], select [Printers and Faxes], and then click [Add a Printer].

3	 Click [Next].

4	 Select the “Network Printer”, and then click [Next].

5	 Enter the machine’s network path in the following format, then click [Next].
http://IP address:HTTP port number/ipp
Example: �When the machine’s IP address is 192.168.1.20, and HTTP port number is 80, enter 

http://192.168.1.20:80/ipp.

6	 Click [Have Disk].

7	 Click [Browse].

8	 Locate the directory on the CD-ROM where the printer driver files are located 
and then click [Open].
•	GDI driver location: 

D:\Package\ENU\bizhub28e\GDI\INSTDATA\Printer\NT
•	PCL 5e driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\5e\NT
•	PCL 6 driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\6\NT
•	PostScript 3 driver location: 

D:\Package\ENU\bizhub28e\PS3\INSTDATA\Printer\NT
•	Fax driver location: 

D:\Package\ENU\COMMON\FAX\INSTDATA\Printer\NT
In this description, the letter of CD drive is “D”.  Substitute the letter of your CD-ROM drive 
for “D”.

9	 Click [OK].
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10	Click [OK].

11	Follow the instructions on the screen.

12	Click [Finish].

13	When the installation is finished, confirm that “Printers” is displayed for the 
name of the installed printer driver.

NOTE

When the optional devices are attached in your machine, see “Setting up printer 
options” (page 1-22) to enable these device.
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Installing via local connection

�� Installing driver

NOTE

•	Do NOT connect the USB cable before installing the driver.
•	You must have administrator privileges in order to install the printer driver.
•	When you are a Windows 10, Windows 8, Windows 7, Windows Server 2012 R2, 

Windows Server 2012 or Windows Server 2008 R2 user, please change the Windows 
setting in advance to installation.  For details, see “Preparation for local installation” 
(page 1-18).

•	If the [User Account Control] window appears when installing on Windows 10 / 
Windows 8 / Windows 7 / Windows Vista / Windows Server 2012 R2 / Windows 
Server 2012 / Windows Server 2008 R2 / Windows Server 2008, click the [Continue] 
or the [Yes].

•	If a message regarding the certificate is displayed during installation, click [Install 
this driver software anyway], [Continue Anyway] or [Yes]. (The displayed message 
and button names may differ according to the version of the operating system you 
are using.)

1	 Insert the installation disk into the CD-ROM drive of the computer.
•	The installer starts automatically.
•	If the installation top screen is not displayed, double-click the “InstMenu.exe” file on the 

disk.
•	If the “AutoPlay” dialog box appears, click [InstMenu.exe].

2	 Select your machine name from the “Select Model” menu, and click [Install 
Drivers].
Click the “Select Language” menu to select the language to display the installer in.

3	 Read the license agreement, and click [I agree] if you agree with the terms.
•	Click [I disagree] return to the installation top screen.
•	Click [< Back] to return to the installation top screen.

4	 Select “Local (connected via USB)”, and click [Next >].

5	 Select the installation type, and click [Next >].
•	If you selected “Typical Installation (Recommended)”, PCL6 Printer / Scanner Driver will be 

installed.  Proceed to step 7.
•	If you selected “Custom Installation”, proceed to step 6.

6	 Select the driver to install, and click [Next >].
Clicking the “+” allows to expand the menu.

7	 Click [Install].
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8	 When the following screen is displayed, connect the computer and the machine 
with a USB cable.

When you are using Windows XP or Windows Server 2003, the “Found New Hardware
Wizard” may appear by connecting the USB cable.  In such case,  see “When found new 
hardware wizard appears” (page 1-19).

9	 When the installation is complete, a screen indicates that the installation is 
completed. Click [Finish].

NOTE

When the optional devices are attached to your machine, see “Setting up printer 
options” (page 1-22) to enable these device.
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�� Preparation for local installation
Before you start the installation, please change the setting of Windows not to download 
the driver from the web site.  If you do not change this setting, installation may take 
longer time.

NOTE

After you have finished the installation, you may better return the setting that you 
changed.

Windows 10, Windows 8, Windows Server 2012 R2  and Windows Server 
2012 users

1	 Display the “Desktop” screen, and start “Explore”.
When using Windows 10, click the Start menu and start “Explore”.

2	 Right-click “Computer” or “My PC” and click “Properties”.

3	 Click “Advanced system settings” in the navigation window.

4	 Click the “Hardware” tab, then [Device Installation Settings].

5	 Check “No, let me choose what to do”, then “Never install driver software from 
Windows Update”.

6	 Click [Save Changes] and close the “System Properties” screen.

Windows 7 and Windows Server 2008 R2 users

1	 Click [Start], right-click [Computer], and click “Properties” from the list.

2	 Click “Advanced system settings”.
When the “User Account Control” dialog box appears, enter an administrator password or 
provide confirmation.

3	 Click “Hardware” tab, and click [Device Installation Settings].

4	 Select “No, let me choose what to do” and choose “Never install driver software 
from Windows Update”.

5	 Click [Save Changes], and close the “System Properties” screen. 



1

In
st

a
ll

in
g

 t
h

e 
d

ri
v

er

Installing to Windows    1-19

�� When found new hardware wizard appears
For Windows XP and Windows Server 2003, when the “Found New Hardware Wizard” 
appears during driver installation, please follow the following procedures.

1	 When the “Found New Hardware Wizard” appears, select “No, not this time” and 
click [Next].

2	 Select “Install from a list or specific location (Advanced)” and click [Next].

3	 Select “Include this location in the search”, and specify the CD-ROM drive. 
Clear any other choices.

4	 Click [Next].
If a message regarding the certificate is displayed, click [Continue Anyway] to install the 
driver.

5	 Follow the instructions that appear on the window until you can click [Finish].

6	 The “Found New Hardware Wizard” will appear again. Repeat the same 
procedures from steps 1 to 5.
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�� Installing printer drivers using the “Add Printer” wizard
We recommend you to install the printer drivers using the installer, however install the 
drivers using the “Add Printer” wizard in following cases:
•	To install multiple printer drivers on a computer while the computer and printer are 

connected with USB cable
•	When you failed to install a correct printer driver by using plug-and-play while a 

network printer driver has already been installed

To install multiple printer drivers on a computer while the computer 
and printer are connected with USB cable

1	 Install the first printer driver using the installation disk.
For details, see “Installing driver” (page 1-16).

2	 Start the “Add Printer” wizard.
•	Windows 10 

Click “All apps” in Start menu  “Windows System”  “Control Panel”  “Hardware and 
Sound”  “Devices and Printers”  “Add a printer”.

•	Windows 8 
Click “Desktop” in Start screen  “Settings” in charm  “Control Panel”  “Hardware and 
Sound”  “Devices and Printers”  “Add a printer”.

•	Windows 7 
Click [Devices and Printers] from the start menu, and click “Add a printer”.

•	Windows Server 2012 R2 / Windows Server 2012 
Click “Control Panel” on the “Start” screen  “Hardware”  “Devices and Printers”  “Add a 
printer”.

•	Windows Vista / Windows Server 2008 R2 / Windows Server 2008 
Click [Control Panel] from the start menu, and click “Hardware and Sound”  “Printers”  
“Add a printer” in that order. 
When the control panel is at “Classic View”, double-click “Printers” and then click “Add a 
printer”.

•	Windows XP Professional / Windows Server 2003 
Click [Printers and Faxes] from the start menu, and click [Add a printer] (on Windows 
Server 2003, double-click “Add printer”).  Click [Next].

•	Windows XP Home Edition 
Click [Control Panel] from the start menu, and click “Printers and Other Hardware”  
“Printers and Faxes”  “Add a printer” in that order.

3	 Select local printer as printer type.
•	Windows 10 / Windows 8 / Windows Server 2012 R2 / Windows Server 2012 

Click “The printer that I want isn’t listed”, and then click “Add a local printer or network 
printer with manual settings.” and click [Next].

•	Windows 7 / Windows Vista / Windows Server 2008 R2 / Windows Server 2008 
Click “Add a local printer”.

•	Windows XP / Windows Server 2003 
Select “Local printer attached to this computer”.  Check to leave free the checkbox 
“Automatically detect and install my Plug and Play printer”.  Click [Next].

4	 Select the USB port to connect the printer, and click [Next].
•	Windows 10 / Windows 8 / Windows 7 / Windows Vista / Windows Server 2012 R2 / Windows 

Server 2012 / Windows Server 2008 R2 / Windows Server 2008 
Click “Use an existing port”, and select the USB port.

•	Windows XP / Windows Server 2003 
Click “Use the following port”, and select the USB port.
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5	 Confirm that the installation disk is in the CD-ROM drive, and click [Have 
Disk].

6	 Click [Browse], and select the folder in the CD-ROM.  Then click [Open].
For details on the driver type, see “Drivers and utilities introduction” (page 1-2).
•	GDI driver location: 

D:\Package\ENU\bizhub28e\GDI\INSTDATA\Printer\NT
•	PCL 5e driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\5e\NT
•	PCL 6 driver location: 

D:\Package\ENU\bizhub28e\PCL\INSTDATA\Printer\6\NT
•	PS3 driver location: 

D:\Package\ENU\bizhub28e\PS3\INSTDATA\Printer\NT
•	Fax driver location: 

D:\Package\ENU\COMMON\FAX\INSTDATA\Printer\NT
In this description, the letter of CD drive is “D”.  Substitute the letter of your CD-ROM drive 
for “D”.

7	 Click [OK].

8	 Confirm the selected printer driver, and click [Next].

9	 Follow the instructions on the screen and install the printer driver.
When the installation is complete, a new printer icon will be added on the printer screen.

When you failed to install a correct printer driver by using plug-and-
play while a network printer driver has already been installed

1	 Uninstall the incorrect printer driver.
Right-click the printer icon, and then select “Delete”.  For Windows 10, Windows 8, Windows 7, 
Windows Server 2012 R2 and Windows Server 2012, select “Remove device”.

2	 Install the correct printer driver using the “Add Printer” wizard.
For details, see “To install multiple printer drivers on a computer while the computer and 
printer are connected with USB cable” (page 1-20) from step 2.
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Setting up printer options
When the optional devices are attached to your machine, enable these devices.
The procedure may slightly vary according to the version of the operating system.

1	 In the printers window, right-click your printer icon, then click [Properties].
For Windows 10, Windows 8, Windows 7, Windows Server 2012 R2 and Windows Server 2012, 
right-click your printer icon, then click [Printer Properties].  When multiple printer drivers 
are installed for your printer, right-click your printer icon and select the printer driver from 
“Printer Properties”.

2	 Select the “Device Options” tab.

3	 Check the options equipped on your machine.

4	 Click [OK].



1

In
st

a
ll

in
g

 t
h

e 
d

ri
v

er

Installing to Mac OS X    1-23

Installing to Mac OS X
With a Macintosh, install the PPD file using the installer.
The installation procedure may slightly vary according to the version of the operating 
system.

Installing via network connection

�� Installing to Mac OS X 10.4, 10.5, 10.6, 10.7, 10.8, 10.9, 10.10, or 10.11

1	 Insert the installation disk into the CD-ROM drive of the computer.

2	 Double-click the CD-ROM and open the folder with the name that has the OS 
version of your computer.

3	 Launch the installer “KONICA MINOLTA bizhub 28e PS.pkg”.

4	 Follow the instructions in the installer to perform the procedure.

5	 After the installation is finished, restart the computer.

6	 Remove the installation disk from the CD-ROM drive after restarting the 
computer.

7	 Select “System Preferences” from  menu.

8	 Click [Print & Fax] (or [Print & Scan] for OS X 10.7 and 10.8, or  [Printers & 
Scanners] for OS X 10.9, 10.10, and 10.11) in “Hardware”.

9	 Click [+].
For OS X 10.7, then select “Add Other Printer or Scanner”.

10	Click [IP] (or [IP Printer] for OS X 10.4), and enter the required items.
•	In the “Protocol” field, select “Line Printer Daemon - LPD” from the pull-down menu.
•	Enter the IP address or DNS name for the printer to connect in the “Address” field.
•	If necessary, enter the name to display in the print job list in the “Queue” field.
•	If necessary, enter the location that the printer is installed in the “Location” field.

11	Select “KONICA MINOLTA bizhub 28e PS” in the “Print Using” field, and click 
[Add].
•	For OS X 10.4, select “KONICA MINOLTA” from the pull-down menu in the “Print Using” 

field, and then select “KONICA MINOLTA bizhub 28e PS”.

•	For OS X 10.5, select “Select a driver to use” from the pull-down menu in the “Print Using” 
field, and then select “KONICA MINOLTA bizhub 28e PS”.  You can filter the drivers by 
entering “KONICA MINOLTA” in the search field.

•	For OS X 10.6, 10.7 and 10.8, select “Select Printer Software” from the pull-down menu in 
the “Print Using” field, and then select “KONICA MINOLTA bizhub 28e PS”.  You can filter 
the drivers by entering “KONICA MINOLTA” in the search field.
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•	For OS X 10.9, 10.10 and 10.11, select “Select Software...” from the pull-down menu in the 
“Use” field, and then select “KONICA MINOLTA bizhub 28e PS”.   You can filter the drivers 
by entering “KONICA MINOLTA” in the search field. 

•	If the driver is not found, select "Other" in the “Print Using” field, and browse to [Library] 
 [Printers]  [PPDs]  [Contents]  [Resources] folder, then select “KONICA MINOLTA 
bizhub 28e PS.ppd.gz”.

12	When the optional devices are attached to your machine, select the device name 
from the pull-down menu.

13	Click [Continue] (or [OK] for OS X 10.7, 10.8, 10.9, 10.10, and 10.11).
•	The printer name is added to the list of registered printers on the left of the “Print & Fax” 

(or “Print & Scan” for OS X 10.7, 10.8, “Printers & Scanners” for OS X 10.9, 10.10 and 10.11) 
screen.

•	If you click [Cancel], the settings are canceled and the display returns to the optional unit 
selection screen.

14	Click [×] to close the screen.

�� Installing to Mac OS X 10.2 or 10.3

1	 Insert the installation disk into the CD-ROM drive of the computer.

2	 Double-click the CD-ROM and open the folder with the name that has the OS 
version of your computer.

3	 Launch the installer “KONICA MINOLTA bizhub 28e PS.pkg”.

4	 Follow the instructions in the installer to perform the procedure.

5	 After the installation is finished, restart the computer.

6	 Remove the installation disk from the CD-ROM drive after restarting the 
computer.

7	 Select “Utilities” from the “Go” menu.
For OS X 10.2, select “Applications” from the “Go” menu.

8	 Click “Printer Setup Utility”.
For OS X 10.2, click “Print Center”.

9	 Click [Add] displayed on the “Printer List” screen.

10	Select “IP Printing” from the pull-down menu, and enter the required items.
•	For OS X 10.3, select “LPD/LPR” from the “Printer Type” pull-down menu.
•	Enter the IP address or DNS name for the printer to connect in the “Printer Address” (for 

OS X 10.3) or “Printer’s Address” (for OS X 10.2) field.
•	If necessary, for OS X 10.2, deselect “Use default queue on server”, and enter the name to 

display in “Queue Name” field.
•	If you click [Cancel], the settings are canceled and the display returns to the IP print 

settings screen.
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11	Select “KONICA MINOLTA bizhub 28e PS” in the “Printer Model” field, and 
click [Add].
•	Select “KONICA MINOLTA” from the pull-down menu in the “Printer Model” field, and then 

select “KONICA MINOLTA bizhub 28e PS”.
•	If the driver is not found, select “Other” in the “Printer Model” field, and browse to [Library] 
 [Printers]  [PPDs]  [Contents]  [Resources]  [en.lproj] folder, then select “KONICA 
MINOLTA bizhub 28e PS.ppd.gz”.

12	Select “KONICA MINOLTA bizhub 28e PS” in the “Printer List”, and then select 
“Show Info” from the [Printers] menu.

13	Setup the printer information, and then click [Apply Changes].
•	Select “Name & Location” and then enter the printer name and location as necessary.
•	When the optional devices are attached to your machine, select “Installable Options” and 

then select the device name from the pull-down menu.

14	Click [×] to close the screen.

Installing via a local connection

1	 Insert the installation disk into the CD-ROM drive of the computer.

2	 Double-click the CD-ROM and open the folder with the name that has the OS 
version of your computer.

3	 Launch the installer.

4	 Follow the instructions in the installer to perform the procedure.

5	 After the installation is finished, restart the computer.

6	 Remove the installation disk from the CD-ROM drive after restarting the 
computer.

7	 Connect the computer and the machine with a USB cable.

8	 Select the printer to use on “Print & Fax”, “Print & Scan”, “Printer List” or 
“Printers or Scanners” screen.
For details on the procedure for displaying the “Printer List” screen, see the manual for the 
operating system.
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Using the machine as a shared printer

�� Setting up a shared printer server

1	 Install the printer drivers on the printer server.
For details, see “Installing via network connection” (page 1-23).

2	 Select “System Preferences” from menu.

3	 Click [Print & Fax].
•	For OS X 10.2, 10.3 and 10.4, click [Sharing].
•	For OS X 10.7 and 10.8, click [Print & Scan].
•	For OS X 10.9, 10.10 and 10.11, click [Printers & Scanners].

4	 Select the printer to share, and check “Share this printer”.
•	For OS X 10.2, 10.3 and 10.4, check “Printer Sharing”.
•	For OS X 10.6, 10.7, 10.8, 10.9, 10.10 and 10.11, check “Share this printer on the network”.
•	If the screen is locked, click the key and enter the user name and password to unlock the 

screen.

5	 Click [×] to close the screen.

�� �Specifying the client side settings (Mac OS X 10.4, 10.5, 10.6, 
10.7, 10.8, 10.9, 10.10, 10.11)

1	 Select “System Preferences” from menu.

2	 Click [Print & Fax].
•	For OS X 10.7 and 10.8, click [Print & Scan].
•	For OS X 10.9, 10.10 and 10.11, click [Printers & Scanners].

3	 Click the [+] below the list on the left.

4	 Click [Default].
For OS X 10.4, click [Default Browser].

5	 Select a printer to share, and click [Add].

6	 When the optional devices are attached to your machine, select the device name 
from the pull-down menu, then click [Continue].
•	For OS X 10.4, click [Printer Setup] and then [Installable Options] to setup the optional 

devices.
•	For OS X 10.5, click [Option & Supplies] and then [Driver] to setup the optional devices.
•	For OS X 10.7 and 10.8, click [OK].
•	For OS X 10.9, 10.10 and 10.11, skip this step.

7	 Click [×] to close the screen.
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�� Specifying the client side settings (Mac OS X 10.3)
Confirm the printer server name and shared printer name to your network administrator.

1	 Select “Applications” from the “Go” menu.

2	 Double-click “Utilities”.

3	 Double-click the “Printer Setup Utility”.

4	 Select a printer to share in the printer list.

5	 Click [×] to close the screen.

�� Specifying the client side settings (Mac OS X 10.2)
For Mac OS X 10.2, when you set up the printer server, you can use the shared printer 
with no set up.
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Basic printing operation
From most application software, you can print by selecting “Print” from the “File” menu.

NOTE

•	The “Print” screen differs according to the application software you are using.
•	Names in menu or button names differ according to the application software you are 

using.

1	 Open the data in the application software, and select “Print” from the “File” 
menu.

2	 Confirm that the name of the printer you want to output from is selected in 
“Select Printer”.
The screen differs according to the application software you are using.

3	 Set the number of copies to print, etc.
If necessary, click [Preferences] to specify the printer driver settings.  For details on the 
printer driver settings, see “Setting the printer” (page 2-4).

4	 Click [Print].
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Canceling a print job
When canceling a print job, first try to cancel it on the computer. If you cannot cancel 
printing on the computer, cancel it on the machine.

NOTE

The procedure may slightly vary according to the version of the operating system.
This section describes the procedure using Windows 7.

Canceling printing on the computer

1	 Click [Start]  [Devices and Printers].

2	 Double click the printer icon.
•	The print queue is displayed.
•	When multiple printer drivers are installed, right-click the printer icon, then select “See 

what’s printing” and select the printer driver.

3	 Right click on the print job you wish to cancel, and click [Cancel].

Canceling printing on the machine

1	 Press [Print] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “Online Mode” (Print 
Ready) screen is displayed.

2	 Press [On Line].

3	 Select the print job you wish to cancel, and press [Delete].

4	 Press [Yes] to cancel printing.
•	Printing will be completed for the page that is currently being printed.
•	Press [No] to continue printing.
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Setting the printer 

Displaying the printer settings screen
This section describes the procedure for displaying the printer settings screen for setting 
the printer function.
The printer settings screen is displayed by clicking “Properties” or “Preferences” in the 
print dialog box of the application software or by right-clicking the printer icon on the 
printers screen of Windows and clicking “Printing Preference”.

NOTE

•	If you change the settings by opening the printer settings screen from the 
application software, the settings are applied only while you use that application 
software, and the settings return to the default values when that application 
software is closed.

•	To register the settings as the default values, open the printer settings screen from 
the printers screen of Windows.

�� From application software

1	 Select “Print” from the “File” menu of the application software.

2	 Click [Preferences].

�� From the “Printers” screen

NOTE

•	It is necessary to log in with administrator privileges to change the print settings.
•	This section describes the procedure using Windows 7.  The procedure may slightly 

vary according to the version of the operating system.

1	 Click [Start]  [Devices and Printers].

2	 Right-click the printer icon, and click “Printing preferences” from the menu.
When multiple printer drivers are installed, right-click the printer icon, then select “Printing 
preferences” and select the printer driver.
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Printer setting screen details

�� Common settings
This section describes the items displayed for all tabs.

Item Description

Setting Information Displays current setting.

About Click this to display the version information for the driver.

Restore Defaults Click this to restore all of the settings on the currently displayed tab to 
their initial defaults.

OK Click this to save the settings and close the dialog box.

Cancel Click this to close the dialog box without saving the settings.

Apply Click this to apply all settings you changed without exiting the dialog box.

Help Click this to display the help for the driver.

Setting 
Information
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�� “Paper” tab

Item Description

Copies This specifies the number of copies printed.

Paper Settings This specifies settings related to the paper to print on.

Document 
Size

Select the document size from the pull-down menu.

Orientation This specifies the orientation (portrait / landscape) of the paper to print on.

Enlarge / 
Reduce

Select either “Zoom” or “Fit to Paper”.
• If you select “Zoom”, specify a zoom ratio (between 25 and 400 %).
• �If you select “Fit to Paper”, the zoom ratio is automatically adjusted to fit 

the paper size to print on.

Paper Size Set the paper size to print on from the pull-down menu.

Custom 
Paper

If you click [Custom Paper Settings], the “Custom Paper Settings” dialog 
box is displayed.

Paper Source Select a paper source in which the paper to print on is loaded from the pull-
down menu.

Paper Type Select the paper type to print on from the pull-down menu.

Cover Sheet Select this to insert a cover sheet from the specified paper cassette in the 
first page.  Click [Cover Sheet Settings], and select the paper source the 
cover sheet is loaded in.  However, you cannot insert a cover sheet when 
combined printing or booklet printing is set.
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�� “Page Layout” tab

Item Description

Combine Select the number of document pages to combine from the pull-down menu.

Print Separator 
Line

Select this to print a separator line between each combined page.

Advanced Click [Advanced] to display the “Layout Settings” dialog.

Watermark*1 Select the watermark to print from the pull-down menu.
You can click [Advanced] to create, edit, or delete watermarks.  For details, 
see “Registering / Editing a watermark” (page 2-29).

First Page 
Only

Select this to only print the watermark on the first page.

Advanced Click [Advanced] to display the “Watermark Settings” dialog.

Duplex / Booklet You can specify the settings for duplex printing and booklet printing.

None / 
Duplex

Select whether to perform one-sided or duplex printing.

Booklet 
Printing

Use this option for multi-page documents to be printed and stacked to 
create a booklet when folded in half in the center.

Binding Position Select the binding position for the document from the pull-down menu.
You can click [Advanced] to set the margin width.

Advanced Click [Advanced] to display the “Binding Margin Settings” dialog box.

*1	 This setting is available on PCL 5e, PCL 6 and PostScript 3 printer driver.
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�� “Print Quality” tab

Item Description

Toner Saving Select “On” to restrict toner consumption.

Resolution Select the printing resolution.

Print Density Set the print density level (between -50 and 50).

Advanced Options

True Type Font 
Printing*1

Select the print processing method when using TrueType fonts.

PostScript Pass 
Through*2

When PostScript Pass Through is enabled, functions such as watermark, 
combine, and booklet printing may not be printed correctly in some 
application software.
For some applications, this is because PostScript data sent to printer cannot 
be controlled by the driver.  In this case, disable “PostScript Pass Through”.
If you disable “PostScript Pass Through”, application software may perform 
unexpected operations. It is recommended that you normally enable this 
function.

Graphic 
enhanced mode*3

The processing of the image data may become slower or printing may not be 
performed correctly, depending on the application.
In such cases, printing may be performed correctly by enabling this setting.
However, it is recommended that you usually use the machine with this 
setting disabled because it may cause printing not correctly.
Click [Advanced] and then check the box for “Graphic enhanced mode” to 
enable this setting.

*1	 This setting is available on PCL 5e and PCL 6 printer drivers, and PostScript 3 printer driver.
*2	 This setting is available on PostScript 3 printer driver.
*3	 This setting is available on GDI the printer driver.
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�� “Destination” tab

Item Description

Sort Select “On” to sort the output into copy sets.

Output Tray*１ Select a paper output destination.

*1	 This function is available only when the optional 2-bin tray is equipped.
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�� “Extended Functions” tab

Item Description

User Authentication*1 Displays the name of the user that is currently logged in.
To change the user, click [Select User], and change the user in the “User 
Authentication” dialog box.
To cancel a user, click [Cancel Selection], and click [OK].
User authentication is required in the following cases:
•Using the security printing function
•When user login is required by the machine policy setting.  For details 
on the machine policy, see chapter 4, “Setting the machine policy” in 
“Setting security” in the Message Board Guide.

Security Printing*1 Select “On” to execute security printing.
To use this function, select the authentication user in advance.

*1	 This can only be used when the machine is connected to a network.



1

2

P
ri

n
ti

n
g

 f
ro

m
 W

in
d

o
w

s

Setting the printer     2-11

�� “Other” tab
The “Other” tab is displayed on PCL 5e, PCL 6, and GDI printer drivers only.

Item Description

Enable duplex setting 
of the application

Check this box when you have set duplex printing on the application 
software but cannot print it correctly.

Enable collate setting 
of the application

Check this box when you have set “collate” (sorting) on the application 
software but cannot sort them correctly.
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Various printing methods

Printing on special paper
You can print on special types of paper.
The following types of paper can be used.
•	Paste Board
•	OHP
•	Envelope / Postcard
•	Custom size paper

NOTE

You cannot use “Combine”, “Duplex” and “Booklet” functions when custom size paper 
is selected.

�� Printing on special paper

1	 Load the paper into the bypass tray, and set the paper size on the machine 
control panel.
For details, see “Loading paper” in the User’s Guide.

2	 Open the printer settings screen on the computer (page 2-4).
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3	 Confirm that the “Paper” tab is selected.

4	 Select the document size from “Document Size”.
Specify the zoom setting, as necessary.

5	 Select the paper size from “Paper Size”.
When you use custom size paper, register the paper size in advance.  For details, see 
“Registering custom paper settings” (page 2-14).

6	 Select “Bypass Tray” in “Paper Source”.

7	 Select the paper type in “Paper Type”.

8	 Click [OK].
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�� Registering custom paper settings
You can register / edit custom paper sizes.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Confirm that the “Paper” tab is selected.

3	 Click [Custom Paper Settings].

4	 Click [Add] and then specify the paper settings.
To change a registered setting, select the custom paper size to change and click [Edit].

Item Description

Custom Paper List A list of the registered custom paper sizes is displayed.

Add Click this to register a new custom paper size.
Up to 50 sizes can be registered. When 50 sizes are registered, this 
button is grayed out.

Edit Select a registered custom paper size, and then click this button to 
edit.

Delete Select a registered custom paper size, and then click this button to 
delete.

Edit Custom Paper You can specify the settings for the custom paper size.
This area becomes active when you click [Add] or [Edit].

Name Enter a name for the custom paper size.
Up to 20 characters can be entered.

Width Set the width of the custom paper size.
The width value cannot be set to a value larger than that of the 
length, even if it is within the setting range.

Length Set the length of the custom paper size.
The length value cannot be set to a value smaller than that of the 
width, even if it is within the setting range.

Unit Select the unit to use for the width and length.

5	 Click [OK].
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Printing on both sides of the paper (Duplex)
You can print on both sides of the paper.

Front Back Front Back

Upper or lower bindingLeft or right binding

NOTE

You cannot use custom size paper for duplex printing.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Select “Duplex” in “Duplex / Booklet”.

4	 Select the binding position in “Binding Position”.
For details, see “Printing with a margin (Binding position)” (page 2-19) on how to add margin 
to the binding position.

5	 Click [OK].
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Printing multiple pages on one sheet (Combine)
A specific number of consecutive pages (two, four, or eight) can be combined and printed 
on one sheet of paper.

[2-up] [4-up] [8-up]

NOTE

•	The zoom ratio is always fixed to auto zoom with the “Combine” function.  A user-
defined zoom ratio cannot be set.

•	You cannot use custom size paper for combine printing.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Select “2-up”, “4-up”, or “8-up” from the “Combine” menu.
•	To add separator line to the printout, check “Print Separator Line”.
•	To change the layout order of the combined sheet, click [Advanced] and select your desired 

order.  Then click [OK].

4	 Click [OK].
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Reducing / Enlarging printing

�� Fitting the zoom ratio to the paper size
You can automatically set the printing zoom ratio according to a specified paper size.
This section describes the procedure for printing an half letter size document on letter 
size paper as an example.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Confirm that the “Paper” tab is selected.

3	 Select “Half Letter (5.5 × 8.5 in)” from the “Document Size” menu.

4	 Select “Letter (8.5 × 11 in)” from the “Paper Size” menu.

5	 Check “Fit to Paper” in “Enlarge / Reduce”.

6	 Click [OK].
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�� Printing with a custom zoom ratio
You can specify the document zoom ratio when printing within 25% to 400%.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Confirm that the “Paper” tab is selected.

3	 Check “Zoom” in “Enlarge / Reduce”, and specify the custom zoom ratio in the 
entry box.

4	 Click [OK].
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Printing with a margin (Binding position)
You can set the binding position and margin for the paper.
You can specify these settings for one side or both sides of the paper.

ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL

ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL

NOTE

The image is shifted according to the set margin, so a part of the image could run off 
the paper when the margin is added.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Select the binding position from the “Binding Position” menu.

4	 Click [Advanced], specify the margin width, and then click [OK].

5	 Click [OK].
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Finishing the output
You can sort the sets when outputting multiple print sets.

4
3

2
1

1
1

1
1

2
2

2
2

3
3

3
3

4
4

4
4

3
4

1
2

3
4

1
2

3
4

1
2

3
4

1
2

Sort OFF
The paper is sorted for each page of the document.

Sort ON
The paper is sorted for each copy.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Destination” tab.

3	 Select “On” for “Sort” to perform sorting.

4	 Click [OK].
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Printing a booklet
Use this option for multi-page documents to be printed and stacked to create a booklet 
when folded in half in the center.

NOTE

You cannot use custom size paper for duplex printing.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Select “Duplex” in “Duplex/Booklet”.

4	 Select the booklet size from the  menu in “Booklet Printing”.
Confirm that “2-up” is selected in “Combine”.

5	 Select the binding position from the “Binding Position” menu.
To specify the margin width, click [Advanced].

6	 Click [OK].
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Printing documents securely
The “Security Printing” function temporarily saves the print data in the memory of the 
machine, and resumes printing after the user is authenticated by the machine.  This 
enables you to prevent the content of printed documents being read by others before you 
retrieve the documents.

Confidential

Confidential

Log in as the user, and print 
the security printing document.

Select a user to perform 
the security printing.

NOTE

Message Board user should be registered in advance to use the security printing 
function.  For details on the Message Board user registration, see chapter 2, 
“Registering users” in the Message Board Guide.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Extended Functions” tab.

3	 Click [Select User] and specify the user, then click [OK].
If the login password is required, enter the password.



1

2

P
ri

n
ti

n
g

 f
ro

m
 W

in
d

o
w

s

Various printing methods    2-23

4	 Select “On” for “Security Printing”.

5	 Click [OK].
The print data is stored in the machine.

6	 Click [Print].

7	 Log in to the machine.
Press <Login>  select your user ID  [Enter]  if necessary, enter the password  [Enter].

8	 Start security printing.
Press [Print] on My MFP Menu screen  [Security Print]  [Print]  [Yes]. 
If My MFP Menu screen is not displayed, press <Mode> repeatedly until My MFP Menu 
screen is displayed.

9	 Log out the machine.
Press <Login>, then press [Yes].

NOTE

•	You cannot print or delete the document individually.
•	When the document is printed, data of the document will be erased from machine 

memory.  
•	The data are stored in the machine for 24 hours at default, and will be deleted after 

that.  You can change the time to store the data.  For details, see “Setting the auto 
deletion time” (page 4-10).
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Changing the print quality

�� Saving toner
The toner saving function enables you to adjust toner consumption and lengthen the 
toner replacement cycle, while retaining the print quality.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Print Quality” tab.

3	 Select “On” for “Toner Saving”.

4	 Click [OK].
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�� Changing the resolution
You can change the resolution (600 × 600 dpi or 300 × 300 dpi) for printing.

A
NOTE

If you perform combined printing or reduced printing with the resolution set to “300 × 
300 dpi”, the text may appear faint, lines may be difficult to see, or watermarks may 
not be printed correctly.  In this case, change the resolution to “600 × 600 dpi”.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Print Quality” tab.

3	 Select the printing resolution from the menu in “Resolution”.

4	 Click [OK].
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�� Changing the print density
You can adjust the density level of the printing result.
You can set adjust the density level to 50 levels of lightness or darkness.

A
Lighten
up to -50

Darken
up to +50A A

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Print Quality” tab.

3	 Adjust the density in “Print Density”.
•	To increase the density level, click [Darken].
•	To decrease the density level, click [Lighten].
•	You can also adjust the density level by dragging the slider in the center to the left or right.
•	Click [Initialize] to return to the default setting.

4	 Click [OK].
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�� Printing with a computer font
You can print a TrueType font as it is displayed on the screen.

NOTE

•	This setting is available on PCL 5e and PCL 6 printer driver or the optional 
PostScript 3 printer driver.

•	The printing speed may decrease, depending on the settings.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Print Quality” tab.

3	 Select the printing method from the “TrueType Font Printing” menu.

•Automatic: Fonts not included in the machine will be downloaded from the 
computer for printing. (Printing is faster.)

•Download as Outline: All the TrueType fonts are downloaded to the machine for printing. 
(Printing may be slower.)

•Download as Bitmap: All the TrueType fonts are sent to the machine as bitmap images. 
(Printing is slower.)

4	 Click [OK].

NOTE

When “Download as Bitmap” is selected, the text may appear faint if combined 
printing or reduced printing is performed in “300 × 300 dpi” resolution.  In this case, 
change the resolution to “600 × 600 dpi”.
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Printing a watermark
You can overlay a watermark (text printed in the background) when printing data created 
in application software.
You can select a watermark provided by default, or register a new watermark.

NOTE

This setting is available on PCL 5e and PCL 6 printer driver or the optional PostScript 
3 printer driver.

�� Printing a Watermark

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Select the watermark to print from the menu in “Watermark”.
•	Check “First Page Only” to print the watermark only on the first page.
•	Click [Advanced] to edit the watermark.  For details, see “Registering / Editing a watermark” 

(page 2-29).

4	 Click [OK].
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�� Registering / Editing a watermark
You can register, edit, or delete watermarks.

1	 Open the printer settings screen on the computer (page 2-4).

2	 Click the “Page Layout” tab.

3	 Click [Advanced] in “Watermark”.

4	 Click [Add].
To change a registered setting, select the custom paper size to change and click [Edit].

5	 Specify the various items in the “Edit Watermark” field.

Item Description

Watermark Displays a list of the registered watermarks.

Add Click this to register a new watermark.

Edit Click this to edit the selected watermark.

Delete Click this to delete the selected watermark.

Name Enter the name to register for the watermark. (Maximum of 30 characters.)

Watermark String Enter a text string to be printed as the watermark. (Maximum of 30 
characters.)

Fonts Select the font to use from the pull-down menu.

Size Set the size of the string (10 to 144 point).

Italic Select this to set the italic style for the string.

Bold Select this to set the bold style for the string.
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Item Description

Angle Select the angle for the string from the pull-down menu.
You can select the following angles for the string:
Horizontal / Vertical / Diagonal / User Set
If you select “User Set”, you can set a custom angle. (Between -180 and 180 
degrees)

Position Select “Center” or “User Defined”.
If you select “User Set”, you can set a horizontal position (between -10.0 and 
10.0) and a vertical position (between -10.0 and 10.0) based on the center of 
the paper.

Shading Select the density for the string from the pull-down menu.

6	 Click [OK] twice.

NOTE

To delete a registered setting, select the registered setting in step 4 and click [Delete].
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PDF direct printing
You can print PDF files without opening them in an application such as Adobe Reader.

NOTE

•	To use PDF direct printing, the optional “PostScript Enabler” is required.
•	You cannot print encrypted PDF files with PDF direct printing.
•	An optional “PostScript Memory” is required to print PDF files that include 

JPEG2000 format images.

Printing

1	 Drag-and-drop the file you want to print to the “bizhub 28e PDF Printing” 
shortcut icon on the desktop.
The “KONICA MINOLTA bizhub 28e PDF DirectPrint” screen is displayed.

Name of document being printed
Status

Progress of document being printed

For multiple documents

Name of document being printed
Status

Progress of document being printed

Progress of all documents to print

You can click [Cancel] to cancel printing.
If you are printing multiple documents, not only the document being printed but all 
documents waiting to be printed are also canceled.

2	 When the printing finishes, click [Close].
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Printer settings

�� Modifying the Print Setting

1	 Double-click the “bizhub 28e PDF Printing” shortcut icon on the desktop.

2	 Specify the print settings.

•	If you click [Restore Defaults], all the settings return to their default values.
•	If you click [Apply], the specified settings are applied.

3	 Click [OK].

�� “Print Settings” tab
Function Description Settings

Copies This specifies the number of copies printed. 1 to 999: 1

Paper Source This specifies the paper source. Auto
Bypass Tray
1st Paper Cassette
2nd Paper Cassette*1

3rd Paper Cassette*1

4th Paper Cassette*1

Paper Type This sets the paper type. Plain
Pasteboard
OHP
Envelope / Postcard

Sort This sets sorting. On
Off

Toner Saving This sets printing with reduced toner 
consumption.

On
Off

Duplex This sets duplex printing. On
Off

*1	 This item is only displayed when it is installed in the machine.

NOTE

Underlined settings are the factory default values.
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�� “Initial Settings” tab
Function Description Settings

IP Address or 
Host Name

Enter the name or IP address of the printer.
You can search the IP address or printer name 
from [Search].

Startup Method • �Create Shortcut on “Desktop” 
Select this to add a shortcut icon for direct 
printing to the desktop.

• �Add a Shortcut to the “Send to” Menu 
Select this to enable direct printing by 
selecting “bizhub 28e PDF Printing” from 
“Send” in the menu displayed when a PDF file 
is right-clicked.

On, Off

On, Off

Installed Options Select this when optional paper cassettes is 
installed in the destination printer.

Not selected by default.

�� “Version Information” tab
Displays the application name, application version, and copyright information.
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Basic printing operation
From most application software, you can execute printing by selecting “Print” from the 
“File” menu.

NOTE

The “Print” screen differs according to the application software you are using.

1	 Open the data in the application software, and select “Print” from the “File” 
menu.

2	 Confirm that the name of the printer you want to output from is selected in 
“Printer”.

3	 Set the number of copies to print and the range of pages to print.
If necessary, switch to the settings screen to specify the printer driver settings.

4	 Click [Print].
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Canceling printing
To cancel printing, try to cancel it on computer first.  If you cannot cancel printing on 
computer, cancel it on the machine.

NOTE

The procedure may slightly vary according to the version of the operating system.

Canceling printing on computer

1	 Select “System Preferences”  “Print & Fax” from the  menu.

2	 Click the icon of the printer that is printing.

3	 Click [Open Print Queue].

4	 Click  of the document you want to cancel printing.
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Canceling printing on the machine

1	 Press [Print] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “Online Mode” (Print 
Ready) screen is displayed.

2	 Press [On Line].

3	 Select the print job you wish to cancel, and press [Delete].

4	 Press [Yes] to cancel printing.
•	Printing will be completed for the page that is currently being printed.
•	Press [No] to continue printing.
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Setting the printer 

Displaying the printer settings screen
The procedure for displaying the printer settings screen for setting the print function is 
indicated below.

1	 Select “Print” from the “File” menu of the application software.

2	 Select the driver to use in “Printer”.

3	 Select “Printer Features”.

4	 Select the feature set.
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Feature set: JCL 1

Item Description

Custom Paper Select this to print on registered custom size paper.

Paper Type Select the paper type to print on.

Toner Saving Select this to restrict toner consumption.

Resolution Select the printing resolution.

Print Density Set the print density level (between -50 and +50).

Binding Width 
(Front)

Set the margin on the front (0 to 30 mm).
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Feature set: JCL 2

Item Description

Binding Width(Back) Set the margin on the back (0 to 30 mm).

Output Tray*1 Select a paper output destination.

*1	 This function is available only when the optional 2-bin tray is equipped.
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Feature set: Watermark 1

Item Description

Edit Watermark Select this to overlay a watermark (text printed in the background of the 
print data) when printing data created in application software.

String Select the string to use for the watermark.

Font Select the font to use for the watermark string.

Size Set the font size for the watermark string (24 to 90 point).

Angle Set the angle for the watermark string (-180° (Landscape) to +180° (Portrait)).

Style Select the style for the watermark string.
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Feature set: Watermark 2

Item Description

Shading Select the density for the watermark.

Print Page 
(Only Mac OS X 10.5, 
10.6, 10.7 10.8, 10.9, 
10.10 and 10.11)

If you select “All Pages”, the watermark is printed on all the pages. If you 
select “First Page Only”, the watermark is printed on the first page only.
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Various printing methods
The procedure may slightly vary according to the version of the Macintosh you are using.
This section describes the procedure using Mac OS X 10.7.

Printing on special paper
You can print on special types of paper.
The following types of paper can be used.
•	PasteBoard
•	OHP
•	Envelope / Postcard
•	Custom size paper

NOTE

You cannot use “Duplex” and “Booklet” functions when custom size paper is selected.

1	 Load the paper into the bypass tray, and set the paper size on the machine 
control panel.
For details, see “Loading paper” in the User’s Guide.

2	 Open the printer settings screen on the computer (page 3-5).

3	 Select “Printer Features”.
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4	 Select the paper type to print on in “Paper Type”.

5	 Click [Print].
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Printing on a custom size paper

NOTE

Resister the custom paper size in advance.  You can register them either by the 
following two procedures:
•	“Paper Size”  “Manage Custom Sizes” in the “Print” dialog box
•	“Page Setup”  “Paper Size”  “Manage Custom Sizes” in the “File” menu.

1	 Load the paper into the bypass tray, and set the paper size you loaded on the 
machine control panel.
For details, see “Loading paper” in the User’s Guide.

2	 Open the printer settings screen on the computer (page 3-5).

3	 Select “Printer Features”.

4	 Select the custom paper size to print on from the menu in “Paper Size”.

5	 Click [Print].
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Printing on both sides of the paper
You can print on both sides of the paper.

NOTE

You cannot use custom size paper for duplex printing.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Click “Two-Sided”.

3	 Select “Layout”.

4	 Select the binding position from the “Two-Sided” pull-down menu.

5	 Click [Print].
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Printing multiple pages on one sheet 
A specific number of consecutive pages (two, four, six, nine, or 16) can be combined and 
printed on one sheet of paper.

4
3

2
1

1 2

3 4

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Layout”.

3	 Select the number to combine from the “Pages per Sheet” menu.
To add separator line to the printout, select the type of the line from “Border” menu.

4	 Select the page layout order in “Layout Direction”.
The image for the page layout order varies according to the number of pages to combine and 
the orientation of the paper.

5	 Click [Print].
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Reducing / Enlarging printing

�� Fitting the zoom ratio to a paper size
You can automatically set the printing zoom ratio according to a specified paper size.
This section describes the procedure for printing an half letter size document on letter 
size paper as an example.

NOTE

This function is only for Mac OS X 10.4 or later.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Paper Handling”.

3	 Select “Half Letter (5.5 × 8.5 in)” from the pull-down menu  in “Paper Size”.

4	 Select “Scale to fit paper size”.

5	 Select “US Letter” from the pull-down menu in “Destination Paper Size”.

6	 Deselect “Scale down only”.
If “Scale down only” is selected, the document will be printed with its original size (100 %).

7	 Click [Print].
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�� Printing with a custom zoom ratio
You can specify the document zoom ratio when printing.

NOTE

You may be able to specify the zoom ratio on the “Print” screen, depending on the 
application.

1	 Select “Page Setup” from the “File” menu of the application software.

2	 Specify a custom zoom ratio in the “Scale” entry box.

3	 Click [OK].

4	 Select “Print” from the “File” menu.

5	 Click [Print].
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Printing with a margin
You can set the binding position and margin for the paper.
You can specify these settings for one side or both sides of the paper.

ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL

ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL
ABCDEFGHIJKL

NOTE

The image is shifted according to the set margin, so a part of the image could run off 
the paper when the margin is added.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Printer Features”.

3	 Select “JCL 1” in “Feature Sets”.

4	 Specify the margin in “Binding Width (Front)”.

5	 To add margin on the backside of the paper, select “JCL 2”.
When you print only on the front side of the paper, proceed to step 7.
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6	 Specify the margin in “Binding Width (Back)”.

7	 Click [Print].
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Finishing the output
You can sort the sets when outputting multiple print sets.

4
3

2
1

1
1

1
1

2
2

2
2

3
3

3
3

4
4

4
4

3
4

1
2

3
4

1
2

3
4

1
2

3
4

1
2

Sort OFF
The paper is sorted for each page of the document.

Sort ON
The paper is sorted for each copy.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Paper Handling”.

3	 Check the “Collate pages” check box on the “Print” screen to sort.
To disable sorting, deselect “Collate pages”.

4	 Click [Print].
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Changing the print quality

�� Saving toner
The toner saving function enables you to adjust toner consumption and lengthen the 
toner replacement cycle, while retaining the print quality.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Printer Features”.

3	 Select “JCL 1” in “Feature Sets”.

4	 Check “Toner Saving”.

5	 Click [Print].
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�� Changing the resolution
You can change the resolution (600 × 600 dpi or 300 × 300 dpi) for printing.

A
NOTE

If you perform combined printing or reduced printing with the resolution set to “300 × 
300 dpi”, the text may appear faint, lines may be difficult to see, and watermarks may 
not be printed correctly.  In this case, change the resolution to “600 × 600 dpi”.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Printer Features”.

3	 Select “JCL 1” in “Feature Sets”.

4	 Select the printing resolution from the menu in “Resolution”.

5	 Click [Print].
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�� Changing the print density
You can adjust the density level to 50 levels of lightness or darkness.

A
Lighten
up to -50

Darken
up to +50A A

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Printer Features”.

3	 Select “JCL 1” in “Feature Sets”.

4	 Adjust the density in “Print Density”.

5	 Click [Print].
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Printing a watermark
You can overlay a watermark (text printed in the background) when printing data created 
in application software. 
You can select a watermark that has been prepared in advance.

1	 Open the printer settings screen on the computer (page 3-5).

2	 Select “Printer Features”.

3	 Select “Watermark 1” in “Feature Sets”.

4	 Select “On” for “Edit Watermark”.

5	 Select the text and font, etc.
To select the shading and the pages to print on, select “Watermark 2” in “Feature Sets”. 
(The “Print page” setting is only available for Mac OS X 10.5 or later.)

6	 Click [Print].
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Printing documents saved in USB memory
You can print PDF or TIFF files located in the root directory of the USB memory device.

NOTE

•	You can print a file up to 20 MB in size.
•	PDF and TIFF files that were scanned and saved with this model in black and white 

format can be printed.
•	When the optional “PostScript Enabler” is installed, you can print color PDF 

document.  Documents are printed in black and white.
•	Encrypted PDF documents that were scanned and saved with this model in black 

and white format can be printed.
•	Only USB memory formatted with FAT12, FAT16, or FAT32 can be used.

1	 Connect the USB memory device to the machine.

2	 Press [USB To Print].

3	 Press [Browse].
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4	 Select the document you want to print, and press [Enter].

•	To review the document properties, press the  located next to the file.  You can check the 
filename, file path, file size, and date and time the file was updated.

•	Press [Root] to return to the root directory of the USB memory.
•	Press [Back] to return to the previous screen.
•	Press [Cancel] to close the screen.
•	You cannot select multiple files at the same time.

5	 Enter the number of copies to print using the numeric keys.

6	 To specify the paper to use for printing, select a paper cassette.

To set the bypass paper, press [Bypass] and set the paper.

7	 To sort the output, press [Sort].  Select the sorting method, and press [Enter].

8	 If the document to print is an encrypted PDF, press [PDF Password].  Enter the 
password, and press [Enter].

9	 Press <Start>.
•	To cancel the printing, press <Stop>.
•	To continue printing other files, press [USB Memory] and repeat the steps from step 3.

10	When printing is finished, disconnect the USB memory device. 
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NOTE

Also, you can perform the “USB to Print” by following procedure.

1	 Press [Print] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “Online Mode” (Print 
Ready) screen is displayed.

2	 Press [USB Memory].

3	 Connect the USB memory device to the machine.

4	 The remaining procedures are the same as from step 3 on page 4-2.
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Print PC folder documents (Print On Demand)
Documents scanned by your machine can be stored in a shared folder on a personal 
computer.  You can then browse your network from your machine and print them.

NOTE

•	You can print documents up to 20 MB in size.
•	PDF and TIFF files that were scanned and saved with this model in black and white 

format can be printed.
•	When the optional “PostScript Enabler” is installed, you can print color PDF 

document.  Documents are printed in black and white.
•	Encrypted PDF documents that were scanned and saved with this model in black 

and white format can be printed.  Encrypted PDF documents in color cannot be 
printed.

1	 Press [Print] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “Online Mode” (Print 
Ready) screen is displayed.

2	 Press [Print On Demand].

3	 Press [Browse].
If the target folder has been registered as a shortcut in advance, select it from the list of 
shortcuts and proceed to step 4.
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4	 Select the document you want to print, and press [Enter].

•	To review the document properties, press the  located next to the file. You can check the 
filename, file path, file size, and date and time the file was updated.

•	Press [Shortcut] to display the list of registered folder shortcuts.
•	Press [Root] to return to the list of root directory.
•	Press [Back] to return to the former screen.
•	You cannot select multiple files at the same time.
•	You may be required to enter your user name and password while browsing.  In that case, 

enter the user name and password to access the PC or folder.

5	 Enter the number of copies to print using the numeric keys.

6	 To specify the paper for printing, select a paper cassette or bypass tray.
To set the bypass paper, press [Bypass] and set the paper.

7	 To sort the output, press [Sort].  Select the sorting method, and press [Enter].

8	 If the document to print is an encrypted PDF, press [PDF Password].  Enter the 
password, and press [Enter].

9	 Press <Start>.
To cancel the printing, press <Stop>.
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Setting the print controller
NOTE

•	This setting is used only when you cannot specify the settings on the printer drivers. 
When settings are available on printer drivers, those settings will be used.

•	This setting is displayed only for PCL 5e or 6 printer drivers is installed.

Setting procedure

1	 Press [Setting] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “My MFP Menu” 
screen is displayed.

2	 Press [Default Settings].

3	 Press [Printer Settings].

4	 Press [Print Controller Setting].

5	 Select the item you want to set.
For details about setting items, see the “List of print controller settings” (page 4-8).

6	 After setting, press [Close].



4-8    Setting the print controller

List of print controller settings

Function Description Settings

Copies Set the number of copies. 1 to 999: 1 set

Orientation Set the print orientation. Portrait
Landscape

Paper Size Set the paper size. Letter, Legal, H.LTR, A4, A5, 
A6, F4, Executive, DL, COM10, 
Monarch, Postcard, OHP (LTR)

Paper Source Set the paper source. Auto
Cassette 1
Cassette 2*1

Cassette 3*1

Cassette 4*1

Bypass

Output Tray *1 Select a paper output destination. Internal Tray
External Tray

Duplex Set whether to use duplex printing. OFF
ON

Binding Set the binding position for duplex printing. Long Edge
Short Edge

Font Set the font to use for printing. Courier, CG Times,
LetterGothic, CG Omega,
Coronet, NwCentSchlbk,
ITCAvantGard, Clarendon,
Universe, AntiqOlive,
Garamond, Marigold,
Albertus, Arial, Symbol,
TimesNewRmn, CourierPS,
Helvetica, Palatino,
ITCBookman, Times,
Windings, ZapfChancery,
ZapfDingbats, SymbolPS

Symbol Set Set the symbol set for the font. ISO 60, ISO 15, ISO L1,
ISO 11, ISO 6, ISO 4,
ISO 69, ISO 21, Legal,
ISO L2, ISO 17, PS Math,
ISO L5, Win L5, MS Publ,
ISO L6, DeskTop, Math-8,
Roman-8, Win L2, 
PC-1004, PC-8TK, Win 3.0,
PS Text, PC-8, PC-8 D / N,
MC Text, PC-850,
ITC Zapf, PI Font, PC-852,
Win 3.1j, Win 3.1 Balt,
Symbol, Win L1, PC-775,
Windings, PC-Cyrillic,
PC-Ukrainian, ISO L / Cyr,
WIN L / Cyr

Font Pitch Set the width for the font.*2 0.44 to 99.99: 10.00 pitch

Font Point Set the font size.*2 4.00 to 999.75: 12.00 point

Resolution Set the resolution. 300 dpi
600 dpi

Timeout Set the time until the machine forcibly prints 
the document when it stops receiving data.

1 to 65535: 300 sec
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Function Description Settings

CR / LF Set the operation to perform when CR / LF is 
received. (Only available for PCL5)

CR / LF only
CR + LF / LF only
CR only / LF + CR
CR + LF / LF + CR

Form Lines Sets the number of lines that can be printed 
on a single page. (Only available for PCL5)

Auto
Manual (5 to 128)

*1	 This item is only displayed when it is installed in the machine.
*2	 The font pitch and font size settings may not be available, depending on the font that is set.

NOTE

Underlined values are the default settings specified at the time of shipment.
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Setting the auto deletion time
You can set the time until stored security print documents are automatically deleted.

1	 Press [Setting] on My MFP Menu screen.
If My MFP Menu screen is not displayed, press <Mode> repeatedly until “My MFP Menu” 
screen is displayed.

2	 Press [Default Settings].

3	 Press [Printer Settings].

4	 Press [Security print auto-delete].

5	 Enter the automatic deletion time, and press [Enter].
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About barcode and OCR fonts
This chapter provides descriptions for types of barcode, character code and samples of 
font usage, etc. for models equipped with the Barcode / OCR font option.  The content 
of this chapter assumes the reader has a basic understanding of barcodes and barcode 
standards.
The barcode relies heavily on printer paper and on the performance of the Barcode 
Reader.  Please read thoroughly before using.

NOTE

To use barcode and OCR fonts, you need the optional Barcode Font Enabler.

Precautions for use

IMPORTANT

•	Barcode can only be used with PCL5e.
•	In order to correctly print and use the barcode font, the application software must 

support the barcode font.
•	It may not be possible to read the printed barcode with all scanners due to 

variations in toner density and paper quality, therefore we recommend that you 
verify the reading ability of the scanner before use.

�� 8-bit code and control code
In order assign the PCL5 command and barcode data character strings, hexadecimal 
digits (00 to 1F) control code and 8-bit code (AA, etc.) must be assigned. The use of "~" (tilde) 
instead of <ESC> and expressing the control code with ASCII character strings by the 
<ESC>**#J (Alternate Escape Code) command is not supported.

�� Start / Stop / Check Digit
Start, Stop and guard bar must be assigned as a character string while being aware of the 
Barcode type. The user must knowingly insert the spaces around the Barcode.
Also, the check digit should be calculated manually from the data that is going to be 
expressed based on the barcode code and the check digit must be inserted into the correct 
position of the data character string. (Generally before the Stop character.)

�� Caption
Caption input is not supported. The user must insert captions as a PCL5 command.
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Types of barcode / OCR fonts
The internal code for the barcode fonts is coded in the barcode symbologies listed below. 
In general, assign a barcode font and data that is going to be expressed based on the 
ASCII character set.  However, be aware that the internal code for fonts may at times be 
encoded using code that is different from ASCII code.

UPC / EAN
UPC and EAN (JAN) are numeric barcodes.  The barcode pattern is defined so that both 
can be expressed as fonts even though they have different standards.  They come in 
standard and abbreviated formats and may be augmented with add-ons.  The check digit 
is modulus 10 with weight 3.
The check digit for a 5-digit add-on is modulus 10 (no check digit with a 2-digit add-
on).  Use ASCII characters 0 to 9 for the font of the left odd parity.  Use Hex 41 to 4A (A 
to J) for the right even parity.  Use Hex 61 to 6A (a to j) for the left even parity. Show all 
numerals 0 to 9.
The gap used for the add-on is defined to Space: Hex 20. The guard bar, center bar, Stop 
for abbreviated format, Start for add-on and delineator for the add-on are come in two 
types: 1) the height is the same as numerals and 2) the bar is underneath the numerals 
and extends out past the numeral. Each are defined in (: Hex28, - : Hex2D,) : Hex29, * : 
Hex2A, + : Hex2B and X : Hex58,] : Hex5D, Y : Hex59, Z : Hex5A, [: Hex5B.

Interleave25
Interleave25 is a numeric barcode.  The barcode must always contain an even number of 
digits because the code represents two numbers, one number encoded in the bar and the 
next number encoded in the space between the bars.  There are multiple check digits that 
are based on standards such as modulus 10 with weight 3 and so on.  Define the font for 
the 00 to 99-pattern by Hex21 to Hex7A. Start is HexAB and Stop is HexAC.

Code39
Code39 is a barcode represented in numerals, upper-case characters and symbols ($, %, 
*, +, -, ., /, space).  The check digit is modulus 43. The font is the same as ASCII code, with 
the exception of the Space symbol. The Space is defined as !: Hex21, , : Hex2C, and _ : 
Hex5F.

Code128
Code128 is a barcode that includes all ASCII characters. Express CodeA, CodeB and 
CodeC with the same bar pattern.  The check digit is modulus 103. As a font, ! to ~ (Hex21 
to 7E) for CodeB is the same as ASCII.  Space is defined as HexAE. DEL: Hex95 to 
StartC: HexAB based on CodeB. Stop is HexAC.
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Postnet (ZIP)
Postnet (ZIP) is a barcode represented as postal code for the United States (ZIP code).  
The check digit is modulus 10. Postnet font consists of numerals (ASCII) contained within 
Framebars (*: Hex2A and }: Hex7C).

Codabar (NW-7)
Codabar (NW-7) is a barcode represented in numerals and symbols ($, +, -, ., /.).  Most 
standards do not define a check digit. Codabar is defined with ASCII code that includes 
numerals, symbols and Start/Stop characters (A, B, C, D).

MSI Plessy
MSI Plessy is a numeric barcode. It is framed by a Start, numeral, check digit, Stop 
pattern and has a modulus 10 check digit.  MSI Plessy fonts are 0 to 9 ASCII code with 
Start (<:Hex3C) and Stop(>:Hex3E) characters.

Barcode / OCR font calling and available parameters

�� Parameters
Parameters v, b and s are available as options for Barcode control. Operate these 
parameters using a different interpretation than the general PCL5 only if the 
T-parameter (Typeface number) shows the Barcode.
The v-parameter assigns the font height. The b-parameter changes the stroke weight 
(width) of the bars. The s-parameter changes the width of the open space between bars.

Example. <ESC>(s16v4b4s24670T

Numeric values for each parameter can be omitted. If omitted, use the default numeric 
value.

Changing the b and s-parameters does not change OCR-A, OCR-B, MSI Plessy and 
PostNet.  Also, for PostNet, assigning the v-parameter does not change the height.  For 
Barcode fonts, parameters p and h are disregarded. For the OCR font, the p-parameter is 
disregarded and the h-parameter is always interpreted as 10.

�� Typeface number
In the barcode, a pattern for the required Bar to express a specific barcode standard is 
assigned to the character code.  If the Bar pattern within the font is the same pattern 
as another Barcode standard, even if the Typeface number of a certain barcode is not 
supported, the Typeface number of the Bar that is not supported can be displayed by 
using the Typeface number that is supported.
For example, the UPC-A for Typeface number 24600 can display UPC-E. In many cases, 
one Barcode font supports two or more Typeface numbers.

24600 UPC-A

24601 UPC-A +2

24602 UPC-A +5

24620 EAN / JAN-8

24621 EAN / JAN-8 +2

24622 EAN / JAN-8 +5

24630 EAN / JAN-13
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24631 EAN / JAN-13 +2

24632 EAN / JAN-13 +5

24640 Interleaved 2 of 5

24641 Interleaved 2 of 5 CHK

24670 Code 39 (3of9)

24671 Code 39 + CHK

24672 Code 39 (3of9) encode space before data

24673 Code 39 + CHK encode space before data

24702 Code 128 B

24704 Code 128 C

24770 ZIP+4 Postnet 5

24771 ZIP+4 Postnet 9

24772 ZIP+4 Postnet 11

24750 Codabar

24751 Codabar +CHKmod16

24760 MSI

24761 MSI +CHKmod10

24762 MSI +Mod10+CHKmod10

24763 MSI +Mod11+CHKmod10

The CHK in the chart refers to presence or non-presence of a check digit but does not 
support the automatic addition of a check digit.  The user must calculate the check digit 
and describe the check digit as data.
The exiting / non-existing CHK that has a Typeface name is nominal. Similarly, the 
descriptions of -13, -8, +2, +5 Typeface names means the number of digits but because the 
user requires a description of the correct barcode notation by using fonts, if the number of 
digits for the barcode with the correct data string is entered, these numbers are nominal.
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Character code list
List the character codes used when assigning the Barcode character.

UPC / EAN
A character code that is used when printing the Barcode Character for UPC/EAN.

Character

Character code

Left side odd parity Left side even parity Right side even parity

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

0 30 0 61 a 41 A

1 31 1 62 b 42 B

2 32 2 63 c 43 C

3 33 3 64 d 44 D

4 34 4 65 e 45 E

5 35 5 66 f 46 F

6 36 6 67 g 47 G

7 37 7 68 h 48 H

8 38 8 69 i 49 I

9 39 9 6A j 4A J

Guard bar 28 (

Center bar 2D -

Stop for 
abbreviated 
format

29 )

Start for  
add-on

2A *

Delineator  
for add-on

2B +

Gap for  
add-on

20 SP
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Interleave25
A character code that is used when printing the Barcode Character for Interleave25.

Character
Character code

Character
Character code

Character
Character code

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

00 21 ! 34 43 C 68 65 e

01 22 " 35 44 D 69 66 f

02 23 # 36 45 E 70 67 g

03 24 $ 37 46 F 71 68 h

04 25 % 38 47 G 72 69 i

05 26 & 39 48 H 73 6A j

06 27 ' 40 49 I 74 6B k

07 28 ( 41 4A J 75 6C I

08 29 ) 42 4B K 76 6D m

09 2A * 43 4C L 77 6E n

10 2B + 44 4D M 78 6F o

11 2C , 45 4E N 79 70 p

12 2D - 46 4F O 80 71 q

13 2E . 47 50 P 81 72 r

14 2F / 48 51 Q 82 73 s

15 30 0 49 52 R 83 74 t

16 31 1 50 53 S 84 75 u

17 32 2 51 54 T 85 76 v

18 33 3 52 55 U 86 77 w

19 34 4 53 56 V 87 78 x

20 35 5 54 57 W 88 79 y

21 36 6 55 58 X 89 7A z

22 37 7 56 59 Y 90 A1

23 38 8 57 5A Z 91 A2

24 39 9 58 5B [ 92 A3

25 3A : 59 5C | 93 A4

26 3B + 60 5D } 94 A5

27 3C < 61 5E ^ 95 A6

28 3D = 62 5F _ 96 A7

29 3E > 63 60 ` 97 A8

30 3F ? 64 61 a 98 A9

31 40 @ 65 62 b 99 AA

32 41 A 66 63 c Start AB

33 42 B 67 64 d Stop AC

NOTE
Assign two character sets for the bar character and space character by a single 
character code.  However, assign the start character and stop character by a single 
character code.
Example: If a bar with a meaning of “3” and a space character set with a meaning of “7” 
is printed, assign “46” (HEX notation).
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Code39
A character code that is used when printing the Barcode Character for Code39.

Character
Character code

Character
Character code

Character
Character code

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 8 38 8 N 4E N

% 25 % 9 39 9 O 4F O

* 2A * A 41 A P 50 P

+ 2B + B 42 B Q 51 Q

- 2D - C 43 C R 52 R

. 2E . D 44 D S 53 S

/ 2F / E 45 E T 54 T

0 30 0 F 46 F U 55 U

1 31 1 G 47 G V 56 V

2 32 2 H 48 H W 57 W

3 33 3 I 49 I X 58 X

4 34 4 J 4A J Y 59 Y

5 35 5 K 4B K Z 5A Z

6 36 6 L 4C L SP 21 !

7 37 7 M 4D M

Codabar (NW-7)
A character code that is used when printing the Barcode Character for Codabar (NW-7).

Character
Character code

Character
Character code

Character
Character code

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 0 30 0 A 41 A

+ 2B + 1 31 1 B 42 B

- 2D - 2 32 2 C 43 C

. 2E . 3 33 3 D 44 D

/ 2F / 4 34 4

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9

: 3A :
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Code128
A character code that is used when printing the Barcode Character for Code128.

Numeric value
Character Character code

Code A Code B Code C HEX notation ASCII notation

0 SP SP 00 20 SP

1 ! ! 01 21 !

2 " " 02 22 "

3 # # 03 23 #

4 $ $ 04 24 $

5 % % 05 25 %

6 & & 06 26 &

7 ' ' 07 27 '

8 ( ( 08 28 (

9 ) ) 09 29 )

10 * * 10 2A *

11 + + 11 2B +

12 , , 12 2C ,

13 - - 13 2D -

14 . . 14 2E .

15 / / 15 2F /

16 0 0 16 30 0

17 1 1 17 31 1

18 2 2 18 32 2

19 3 3 19 33 3

20 4 4 20 34 4

21 5 5 21 35 5

22 6 6 22 36 6

23 7 7 23 37 7

24 8 8 24 38 8

25 9 9 25 39 9

26 : : 26 3A :

27 ; ; 27 3B ;

28 < < 28 3C <

29 = = 29 3D =

30 > > 30 3E >

31 ? ? 31 3F ?

32 @ @ 32 40 @

33 A A 33 41 A

34 B B 34 42 B

35 C C 35 43 C

36 D D 36 44 D

37 E E 37 45 E

38 F F 38 46 F

39 G G 39 47 G
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Numeric value
Character Character code

Code A Code B Code C HEX notation ASCII notation

40 H H 40 48 H

41 I I 41 49 I

42 J J 42 4A J

43 K K 43 4B K

44 L L 44 4C L

45 M M 45 4D M

46 N N 46 4E N

47 O O 47 4F O

48 P P 48 50 P

49 Q Q 49 51 Q

50 R R 50 52 R

51 S S 51 53 S

52 T T 52 54 T

53 U U 53 55 U

54 V V 54 56 V

55 W W 55 57 W

56 X X 56 58 X

57 Y Y 57 59 Y

58 Z Z 58 5A Z

59 [ [ 59 5B [

60 \ \ 60 5C \

61 ] ] 61 5D ]

62 ^ ^ 62 5E ^

63 _ _ 63 5F _

64 NUL ' 64 60 '

65 SOH a 65 61 a

66 STX b 66 62 b

67 ETX c 67 63 c

68 EOT d 68 64 d

69 ENQ e 69 65 e

70 ACK f 70 66 f

71 BEL g 71 67 g

72 BS h 72 68 h

73 HT i 73 69 i

74 LF j 74 6A j

75 VT k 75 6B k

76 FF l 76 6C l

77 CR m 77 6D m

78 SO n 78 6E n

79 SI o 79 6F o

80 DLE p 80 70 p

81 DC1 q 81 71 q

82 DC2 r 82 72 r
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Numeric value
Character Character code

Code A Code B Code C HEX notation ASCII notation

83 DC3 s 83 73 s

84 DC4 t 84 74 t

85 NAK u 85 75 u

86 SYN v 86 76 v

87 ETB w 87 77 w

88 CAN x 88 78 x

89 EM y 89 79 y

90 SUB z 90 7A z

91 ESC { 91 7B {

92 FS | 92 7C |

93 GS } 93 7D }

94 RS ~ 94 7E ~

95 US DEL 95 A1

96 FNC3 FNC3 96 A2

97 FNC2 FNC2 97 A3

98 SHIFT SHIFT 98 A4

99 CODE C CODE C 99 A5

100 CODE B FNC4 CODE B A6

101 FNC4 CODE A CODE A A7

102 FNC1 FNC1 FNC1 A8

103 START (CODE A) A9

104 START (CODE B) AA

105 START (CODE C) AB

106 STOP AC

Postnet (ZIP)
A character code that is used when printing the Barcode Character for Postnet (ZIP).

Character
Character code

HEX notation ASCII notation

0 30 0

1 31 1

2 32 2

3 33 3

4 34 4

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9

Framebar 2A *

Framebar 7C |



5-12    Character code list

MSI Plessy
A character code that is used when printing the Barcode Character for MSI Plessy.

Character
Character code

HEX notation ASCII notation

0 30 0

1 31 1

2 32 2

3 33 3

4 34 4

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9

Start 3C <

Stop 3E >
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Sample of barcode / OCR font use
The surrounding blank area and caption are not included in the following example.  
Escape code <ESC> and carriage return code <CR> are required for code value input.  
The value of nn is a hexadecimal digit for items listed as <Hexnn>. Input for the 
corresponding code is required.
Generally for these samples, first a position set command is needed to choose the 
preferred Barcode font.  Afterwards, this position set command is needed to return to the 
general text font from the Barcode font.

UPC-A
Data to be displayed
03600029145(Check Digit 2)
<ESC>(8Y<ESC>(s12vbs24600T(036000-CJBEFC(<CR>

UPC-E
Data to be displayed
654321 (Check Digit 7 in EOEOEO:E(Even), O (Odd))
<ESC>(8Y<ESC>(s12vbs24600T(g5e3c1)<CR>

EAN13
Data to be displayed
491234567890 (The prefix for 4 in OEOOEE, Check Digit 4)
<ESC>(8Y<ESC>(s12vbs24630T(9b23ef-GHIJAE(<CR>

EAN8
Data to be displayed
4912345 (Check Digit 6)
<ESC>(8Y<ESC>(s12vbs24620T(4912-DEFG(<CR>

Interleave25
Data to be displayed
0400763000011 (Check Digit 6)
<ESC>(4Y<ESC>(s12vbs24640T<HexAB>%!m?!"1<HexAC><CR>

Code39
Data to be displayed
01234567890123 (Check Digit 8)
<ESC>(0Y<ESC>(s12vbs24670T*012345678901238*<CR>

Code128
Data to be displayed
<StartC><FNC1>123456<CodeB>A1(Check Digit C)
<ESC>(19Y<ESC>(s12vbs24702T<HexAB><HexA8>,BX<HexA6>A1C<HexAE><CR>

Postnet
Data to be displayed
123456789 (Check Digit 5)
<ESC>(15Y<ESC>(s12vbs24771T1234567895<CR>
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Codabar
Data to be displayed
A19+1243B (Check Digit :)
<ESC>(5Y<ESC>(s12vbs24750TA1941243:B<CR>

MSI Plessy
Data to be displayed
1234567 (No Check Digit)
<ESC>(6Y<ESC>(s12vbs24760T<1234567><CR>

OCR-A
Data to be displayed
12345ABCDE
<ESC>(0O<ESC>(s12vbs104T12345ABCDE<CR>

OCR-B
Data to be displayed
12345ABCDE
<ESC>(1O<ESC>(s12vbs110T12345ABCDE<CR>
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Troubleshooting
Read this section if trouble occurs.  Contact your authorized local dealer if the following 
steps do not solve the problem.

Cannot install the driver

Status Things to check Countermeasure

Cannot install the 
driver

Did you follow the 
installation procedure?

Perform the installation by following the 
procedure indicated in the manual.

Are you logged in as a 
restricted user (with User 
privileges)?

Log in with a user account that has 
Administrator privileges, and perform the 
installation.

Is there a problem with the 
computer?
 �Is Windows unstable?
 �Is the CD-ROM drive 

operating correctly?

Try performing the installation again after 
restarting the computer.
Check the operation of the CD-ROM drive. 
See the help, etc. for your computer.

Is there a problem with the 
installation CD-ROM?

Check whether the CD-ROM can be read in 
the Explorer of Windows.
If there is a problem with the installation 
disk, contact your authorized local dealer.

Did you perform the 
installation in a supported 
environment?

Check the list of supported operating systems.  
For details, see “System requirements” (page 
1-4).

Is there any security 
software or port monitoring 
software running?

Close any security software or port 
monitoring software, and perform the 
installation again.  See the help, etc. for your 
computer.
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Cannot print documents

Status Things to check Countermeasure

Cannot print 
documents

Have you checked the 
network environment?

See chapter 4, “Cannot connect to the 
network” in “Troubleshooting” in the 
Administrator’s Guide to check the network 
environment.

Is paper loaded? Load the paper properly.  For details, see 
“Loading Paper” in the User’s Guide.

Has the toner run out?  Has 
the drum cartridge reached 
the end of its life?

Check the screen of the machine, and if 
a message is displayed, replace the toner 
cartridge and drum cartridge. For details, see 
chapter 3, “Replacing consumables” in the 
Administrator’s Guide.

Is the system memory of the 
computer insufficient?

Check whether the memory capacity of the 
computer meets the requirements.
If the requirements are not met, increase 
the memory of the computer.  If multiple 
applications or unnecessary resident 
programs are running, close them.

Is the printer driver 
installed?

Install the printer drivers.  For details, see 
“Installing the driver” (page 1-1).

Is the correct printer 
selected?

Select your desired printer in the print menu 
of the application.

Is the printing port correct? Check whether the printing port is correct 
in the properties screen of the printer driver. 
See the help, etc. for your computer.
If the machine is connected via a USB cable, 
confirm that “USBxx” (where “xx” refers to 
the port number) is selected. If the machine 
is connected via a network, confirm that an 
lpr port with the same address as the IP 
address set in the machine is selected.

Are you printing from Mac 
OS X 10.2 via USB cable? 

When you print from Mac via USB cable, the 
following settings are not available:  Paper 
Type, Toner Saving, Print Density, Binding 
Width (Front), and Binding Width (Back). 
Print via network or upgrade your Mac 
version to Mac OS X 10.3 or later.

Is the right printer driver 
installed on your computer?

When you have installed a network printer 
driver in advance and then tried to install 
a driver using plug-and-play, the correct 
printer driver may not be installed.
If the correct printer driver is not installed, 
reinstall it using the “Add Printer” wizard.
For details, see “Installing printer drivers 
using the “Add Printer” wizard” (page 1-20).

Is user authentication set? According to the machine policy, you cannot 
print documents when user authentication is 
not set.  Set the user authentication in such 
case.  For details, see ““Extended Functions” 
tab” (page 2-10).
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Status Things to check Countermeasure

Cannot print 
documents

Is the machine online? Printing is available when the machine is 
online.
To switch the machine to online:
Press [Off Line] on the print ready screen.
(If the print ready screen is not displayed, 
press <Mode> repeatedly until “Print Ready” 
screen is displayed.)

Cannot print 
correctly

Are the paper size and 
orientation settings, etc. 
set in the application being 
prioritized?

The settings of the application software may 
be prioritized, depending on the settings 
of the printer driver.  Specify the correct 
settings in the application software.

Does the machine have 
sufficient memory for 
printing?

If you are printing multiple sets, first check 
whether you can print one set. Set a lower 
image resolution. Alternatively, reduce the 
size of the data by simplifying the image.

Cannot print PDF 
documents correctly 
using KONICA 
MINOLTA bizhub 
28e PDF DirectPrint 
or operating from 
machine control 
panel.

Is the optional PostScript 
Memory attached?

You may print them correctly when the 
optional PostScript Memory is attached.

Are the fonts embedded in 
the PDF file?

When the characters are garbled, you may 
print them correctly by creating a PDF file 
with the fonts embedded in the file.
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Uninstalling the printer driver

For Windows
This section describes the procedure using Windows 7.  The procedure may slightly vary 
according to the version of the operating system.
You must have administrator privileges in order to uninstall the printer driver or utilities.

1	 Select [Control Panel] from [Start] menu.

2	 Click [Programs], and then [Uninstall a program].
The procedures are when your control panel is set to “View by: Category”.  When it is set 
either to “View by: Large icons” or “View by: Small icons”, click [Programs and Features].

3	 Select the printer driver you want to delete, and click [Uninstall].

4	 Click [Yes].

5	 Follow the instructions on the screen.
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For Macintosh
This section describes the procedure using OS X 10.5.  The procedure may slightly vary 
according to the version of the operating system.

1	 Open the “Print & Fax” window.
The “Print & Fax” window can be opened from the “System Preferences” in the “Apple Menu” 

2	 Select the printer name to be deleted, and then click [–].
The selected printer is deleted.

3	 Close the [Print & Fax] window.

NOTE

•	You can delete the files installed by using the “KONICA MINOLTA bizhub 28e 
PS.pkg” when you double-click the “uninstall_bizhub28e (or “uninstall_bizhub28e.
command” for 10.2, 10.3, and 10.4) file on the installation disk.   
To delete, open the folder with the name of your operating system version, and then 
double-click “uninstall bizhub 28e” (or “uninstall_bizhub28e.command” for 10.2, 
10.3, and 10.4).
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